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| INTRODUCTION
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This application calculates the theoretical acoustical impedance,
acoustical power, electrical impedance, diaphragm displacement, phase
response and group delay versus frequency characteristics of direct
radiator and finite and infinite horn loaded loudspeakers.

Finite horns radiating into free space, half space, quarter space or eighth
space can be analysed (4 x Pi, 2 x Pi, Pi or Pi / 2 steradians solid
angle).

Horn systems can have an oblate spheroidal waveguide, a single Le Cléac'h,
Bessel, tractrix, radius, spherical wave or Salmon's family
hyperbolic-exponential flare segment, or up to four conical, exponential
and/or parabolic flare segments connected in series, coupled to a throat
chamber, loudspeaker driver and acoustically lined or vented rear chamber.



Horns with multiple drivers and arrays of multiple loudspeakers can be
modelled.

A parabolic (Par) flare should be used when simulating a rectangular
cross-sectional area horn segment having two parallel straight sides and
two sloping straight sides, where the area varies linearly with axial
length.

Horn segment parameter values can be reset to zero by entering a blank for
the throat area, mouth area, axial length, flare cutoff frequency, flare
parameter or throat entry half-angle.

By default, at the common boundary between two horn segments in a
multiple-segment horn the cross-sectional areas are the same for each
segment. The mouth area of the first segment is equal to the throat area
of the second segment. Double-clicking on any segment area label in edit
mode allows different cross-sectional areas to be specified at the common
boundary. The mouth area of the first segment does not necessarily have to
be the same as the throat area of the second segment. This will result in
a step transition at the common boundary. All horn segment area labels are
shown in red when stepped segments are specified.

When stepped segments are specified it is not possible to use the Multiple
Entry Horn Wizard, export schematic diagram horn data, print the schematic
diagram, export an AkAbak script or open the current record in the
Wavefront Simulator.

For multiple-segment horns, the more that the value of Cir (mouth
circumference in flare cutoff frequency wavelengths) exceeds 1 for any horn
segment, the less accurate the calculated throat acoustical impedance and
other results become.

The application assumes that the velocity of sound in air is 344 metres per
second, and that the density of air is 1.205 kilograms per cubic metre.

The driver diaphragm is modelled as a rigid plane circular piston. No
allowance is made for frequency-dependent directional characteristics due
to driver cone angle or cone material, or for changes in moving mass,
acoustical impedance or radiated power caused by diaphragm resonance modes.

Horn transmission losses are assumed to be zero, unless absorbent filling
material is specified.
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| INPUT PARAMETERS WINDOW
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Moving the mouse pointer over an object or message on the input parameters
window displays a context-sensitive explanatory note in the status bar



panel at the bottom of the window.

After calculating results by pressing F5 or clicking the Calculate button,
press F2 to move to the next window, Shift+F2 to move to the previous
window or Esc or F5 to return to the input parameters window from any
result window.

Press the S key to instantly check the schematic diagram. Release the S
key to immediately return to the previously displayed chart or input
parameters window.

To enter a length, area or volume value in Imperial inch or foot units,
press F6 in edit mode when the relevant input parameter has the focus.

Double-click the Eg label in edit mode or press V or A when the Eg text box
has the focus to select the Vel constant diaphragm velocity or Acc constant
diaphragm acceleration option. Not applicable to ME1, ME2, BP4, BP6, BPS8,
DBR or ABC records. Double-click the Acc label in edit mode or press E
when the Vel or Acc text box has the focus to re-select the Eg constant
amplifier open circuit voltage option. The Eg, Vel and Acc default values
can be changed as required.

Double-click the Cir or Fta label in edit mode to select the Clo closed
horn mouth option. Not applicable to direct radiator loudspeakers, tapped
horns or single segment horns other than Con, Exp or Par.

Double-click the Le label in edit mode to select the lossy inductance
option, and to more accurately simulate loudspeaker systems having drivers
with large motors. Not applicable to ME1 and ME2 records. The lossy
inductance model was derived empirically from experimental data and adjusts
the value of Bl as necessary to achieve the desired result. The adjusted
Bl value can be seen in the bottom status bar panel by moving the mouse
pointer over the Bl label or text box. A red Le label indicates that the
lossy inductance option has been selected.

Double-click the Le text box in edit mode to select the Semi-Inductance
Model. Not applicable to ME1l and ME2 records. A green Le label indicates
that the semi-inductance model has been selected.

Double-click the Cms label in edit mode to select the Frequency-Dependent
Damping or FDD Model. Not applicable to ME1 and ME2 records. A green Cms
label indicates that the FDD model has been selected.

Press the F8 function key in edit mode to reset the current record filter
parameters to their default values.

|Radiation, Source and Mouth Parameters

Ang Solid radiation angle (steradians).



Enter 4, 2, 1 or 0.5 for finite horn, @ for infinite horn, or
double-click the Ang label in edit mode.

Eg Amplifier open circuit root-mean-square voltage (volts).
Vel Driver diaphragm constant rms velocity (m/sec).

Acc Driver diaphragm constant rms acceleration (m/sec”2).

Rg Amplifier output resistance (ohms).

Cir  Free space normalised horn mouth circumference in flare cutoff
frequency wavelengths.

Fta Horn mouth flare tangent angle (degrees).

|Horn Parameters

S1 Horn segment 1 throat area (sq cm).
S2 Horn segment 1 mouth area and horn segment 2 throat area (sq cm).

L12 Horn segment 1 axial length (cm).
To select Con, Exp or Par flare in edit mode, press C, E or P when
the relevant horn segment length parameter has the focus or double-
click the length label. The length value must be non-zero to
preserve the flare setting. To select Bes, Hyp, Lec, Obl, Rad, Sph
or Tra flare in edit mode, press B, H, L, O, R, S or T when the L12
length parameter has the focus.

F12  Horn segment 1 flare cutoff frequency (hertz).

m Bessel horn flaring index.
Enter @ for cylindrical, 1 for parabolic, 2 for conical, 99999 for
exponential or -2 for Gabriel's horn.

T Hyperbolic-exponential and Le Cléac'h horn flare parameter.
Enter @ for catenoidal, < 1 for cosh, 1 for exponential, > 1 for sinh
or 99999.99 for conical.

R Radius horn flare profile radius (cm).

AT Horn throat entry half-angle (degrees).

Multiple Segment Horn
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| Traditional Driver Parameters
Sd Driver diaphragm piston area (sq cm).
Bl Driver magnetic flux density x voice coil conductor length (tesla.m).

Cms Driver diaphragm suspension mechanical compliance (m/newton).
Rms  Driver diaphragm suspension mechanical resistance (newton.sec/m).

Mmd  Driver diaphragm and voice coil dynamic mechanical mass (gm).
Mmd equals Mms (total moving mass) minus air load.

Le Driver voice coil inductance (millihenrys).

Re Driver voice coil dc resistance (ohms).

Nd Number and position of drivers in loudspeaker.
Specify driver system configuration using the Driver Arrangement
tool.

fs Driver free-air resonance frequency (hertz).

Vas Volume of air that provides a restoring force equal to that of the
driver's mechanical compliance (litres).

Qes Driver resonant electrical Q at the driver resonance frequency, due
solely to inherent electromagnetic damping.

Qms  Driver resonant mechanical Q at the driver resonance frequency, due
solely to internal mechanical damping.

Qts Driver total Q.
Pmax Driver rated thermal limited electrical input power (watts).
Xmax Driver diaphragm linear mean-to-peak displacement limit (mm).

For a dual voice coil driver with the two coils connected in series,
specify Re = 2 x Rel, Le = 2 x Lel and Bl = 2 x Bll where Rel, Lel and Bl1l



are the parameter values for one coil.

For a dual voice coil driver with the two coils connected in parallel,
specify Re = Rel / 2, Le = Lel / 2 and Bl = Bl1l where Rel, Lel and Bl1l are
the parameter values for one coil.

For a dual voice coil driver with the two coils connected in either series
or parallel, Qes = Qesl / 2 where Qesl is the parameter value for one coil.

| Advanced Driver Parameters For Semi-Inductance Model
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Re' Resistance (ohms).

Leb Free inductance (millihenrys).
Le Bound inductance (millihenrys).
Ke Semi-inductance (semi-henrys).
Rss Shunt resistance (ohms).

|Advanced Driver Parameters For Frequency-Dependent Damping or FDD Model

Rms Mechanical resistance (newton.sec/m).
Ams Admittance (m/newton).

| Chamber Parameters
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Vrc  Rear chamber volume (litres).

Lrc  Rear chamber average length (cm).

Fr Rear chamber acoustical lining airflow resistivity (mks rayls/m).
Tal Rear chamber acoustical lining thickness (cm).

Frl  Absorbent filling material airflow resistivity (mks rayls/m).
Tall Absorbent material filled length (cm and percent).

Ap Vented rear chamber port cross-sectional area (sq cm).

Lpt Vented rear chamber port tube length (cm).

Apl Throat port or throat adaptor entry cross-sectional area (sq cm).



Ap2  Absorber chamber port cross-sectional area (sq cm).

Lp Throat or absorber chamber port or throat adaptor length (cm).

Vtc Throat chamber volume (cc).

Atc Throat chamber average cross-sectional area normal to axis (sqg cm).

Spl Passive radiator diaphragm piston area (sq cm).
Spl = 1 passive radiator, Sp9 = 9 passive radiators.

Cmp  Passive radiator suspension mechanical compliance (m/newton).

Rmp  Passive radiator suspension mechanical resistance (newton.sec/m).

Mmp  Passive radiator diaphragm dynamic mechanical mass (gm).

The rear chamber volume is the effective enclosed air volume behind the
driver diaphragm, including any space occupied by acoustical lining
material but excluding port tube, driver magnet and chassis assemblies.

The throat chamber volume is the effective air volume between the driver
diaphragm and the throat chamber port, the throat adaptor entry or the horn
throat.

The locations of the throat chamber and rear chamber are as shown in the
schematic diagram.

Set relevant values to zero if no throat chamber, rear chamber, acoustical
lining, port tube or throat adaptor.
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|DEFAULT RESULT WINDOWS
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| Schematic Diagram

Loudspeaker schematic diagram and system volume. The design is assumed to
be axisymmetric. Use the mouse pointer to identify component parts and
show scale.

|Acoustical Impedance
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Horn throat acoustical resistance and reactance in normalised acoustical
ohms versus frequency in hertz. The actual cgs acoustical resistance and
reactance can be determined by multiplying the chart values by the given
scaling factor.



|Acoustical Power
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Constant directivity sound pressure produced at a point source normalised
distance of one metre when the driver is supplied with a signal of a given
voltage, versus frequency in hertz. The level is expressed in decibels
relative to the standard reference sound pressure of 20 micropascals. The
acoustical power output producing the constant directivity sound pressure
is assumed to radiate uniformly into the solid angle specified by the Ang
input parameter.

The Directivity Response tool can be used to take into account the
frequency dependent directional characteristics of direct radiating single
drivers and finite single-segment horns.

Double-click anywhere on the Y-axis vertical SPL scale to switch from the
default 5 dB increments to either 6 dB or 3 dB increments.

|Electrical Impedance
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Loudspeaker electrical input impedance magnitude in ohms versus frequency
in hertz.

|Diaphragm Displacement
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One-way maximum displacement of the driver diaphragm from its mean position
in millimetres for a specified input signal, versus frequency in hertz.

The actual displacement can be determined by dividing the chart value by
the scaling factor, where given.

Behaviour at all input voltage levels is assumed to be linear. No
allowance is made for low frequency high power amplitude compression.

Each diaphragm in a multiple driver configuration has the same
displacement, as given by the calculated value.

|Phase Response

LSLNT VLN NV NE N NTNY NN NI N N

Phase-angle difference in degrees between the input signal voltage and the
output sound pressure of a loudspeaker system, versus frequency in hertz.

Standard wrapped phase is displayed by default. The Delay tool can be used
to add a linear phase offset, or to remove an existing offset and restore
standard wrapped phase. The default offset delay correction value is
equivalent to the mean group delay across the -12 dB delimited SPL
bandwidth.



| Group Delay
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Negative derivative in milliseconds of the loudspeaker system phase
response, versus frequency in hertz.

Group delay is a measure of the rate of change of phase with respect to
frequency, and is positive when the phase slope is negative.

| TOOLS MENU

|Radiation Angle
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Specifies the placement of the loudspeaker, and the solid angle into which
the loudspeaker radiates. The solid angle is measured in steradians. Set
the value to zero to specify an infinite horn.

The Tools menu command is enabled when Ang has the focus. The tool can
also be selected by double-clicking the Ang text box in edit mode.

|Horn Segment Wizard
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Calculates either the throat area, mouth area, axial length, flare cutoff
frequency, flare parameter, throat entry half-angle, mouth circumference in
cutoff frequency wavelengths or mouth flare tangent angle, given the other
relevant horn segment parameters. Cir or Fta can be set to a specified
value when the mouth area or flare cutoff frequency calculation option is
selected.

The Tools menu command is enabled when any horn segment parameter or the
Apl throat adaptor parameter has the focus. The tool can also be selected
by double-clicking the parameters in edit mode. The mouth area calculation
option can be used to determine the cross-sectional area at any point along
the axial length of a horn segment. For system volume, double-click
segment volume.

|Hypex Approximator

Approximates a specified hyperbolic-exponential horn using up to four
conical, exponential or parabolic segments.

To change the flare of a horn segment, double-click on the label above the
length slider control. If the label is double-clicked while the Ctrl key



is pressed, all segments are set to the same flare.

To change the Auto / Manual setting of an area slider control, double-click
on the label above the area slider.

To directly set an enabled slider control to a specified value, key in the
value and then press Enter while the control has the focus.

The volume difference value is the sum of the segment volumes minus the
volume of the specified hyperbolic-exponential horn. The value is positive
when the sum of the segment volumes is greater than the
hyperbolic-exponential horn volume. The value is negative when the sum of
the segment volumes is less than the hyperbolic-exponential horn volume.

The Tools menu command can be accessed when either S1, S2, L12 (Hyp) or T
for a hyperbolic-exponential horn has the focus, and S2 is not greater than
99999.99.

|Calculate Parameter

Derives Bl, Cms, Rms, Mmd, Cmp, Rmp and Mmp values from relevant
Thiele-Small parameters, calculates Eg given the power delivered to a
specified load and determines the Helmholtz resonance frequency given Lpt.

When selected from Sd, displays the driver Thiele-Small parameters Sd, Re,
fs, Vas, Qes, Qms and Qts, and the electro-mechanical parameters Le, Pmax
and Xmax. The values of all parameters shown can be edited, except for
Qts.

When selected from Spl to Sp9, displays the passive radiator Thiele-Small
parameters Sp, fs, Vas and Qms. The values of all parameters shown can be
edited.

The Tools menu command is enabled when Eg, Sd, Bl, Cms, Rms, Mmd, Spl to
Sp9, Cmp, Rmp, Mmp or Lpt has the focus. The tool can also be selected by

double-clicking the parameters in edit mode.

| Chamber Type

Specifies a lined, vented or passive radiator rear chamber, a ported throat
chamber, ported stub or a throat chamber coupled to the horn throat by a
conical, cylindrical, exponential or parabolic adaptor.

The Tools menu command is enabled when the input parameters window is in
edit mode. The chamber configuration can also be selected by
double-clicking the Fr, Tal, Ap, Lpt, Apl, Ap2, Lp, Spl or Cmp label.

Press the Ctrl key and double-click the Fr, Tal, Ap, Lpt, Apl or Lp label
to specify a passive radiator. Press the Ctrl key and double-click the Spi



label to specify multiple passive radiators. Double-click the Spl to Sp9
or Cmp label to restore the default Fr label. Double-click the Lp label in
edit mode or press C, E or P when the Lp text box has the focus to specify
a conical, cylindrical, exponential or parabolic flare throat adaptor or
absorber chamber port. The flare can also be specified by double-clicking
the label above the Lp slider control in the Loudspeaker Wizard tool.

|Driver Arrangement
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Specifies the number and position of driver modules connected electrically
in series and/or parallel. A driver module can contain a single driver, or
up to 9 drivers connected in a series or parallel isobaric configuration.

The 'Multiple Driver Equivalent' option enables a given single driver to be
replaced by a multiple driver array having the same performance.

Multiple drivers share the horn system, throat chamber and rear chamber as
defined by the input parameter values and as shown in the schematic
diagram. An offset driver horn, a tapped horn, a compound horn, a multiple
entry horn, a 4th order, 6th order series, 6th order parallel or 8th order
band pass enclosure, or a double bass reflex or an aperiodic bi-chamber
enclosure can be specified.

The tool can be selected by double-clicking the Nd, OD, OD1, TH, TH1, CH,
CH1, ME1, ME2, BP4, BP6, BP8, DBR or ABC disabled text box in edit mode.

Double-clicking the input parameters window driver arrangement label in
edit mode steps through the Nd, OD, OD1, TH, TH1, CH, CH1 driver
arrangement options.

Pressing the Ctrl key and double-clicking the input parameters window
driver arrangement label in edit mode steps through the ME1, ME2, BP4, BP6,
BP8, DBR, ABC driver arrangement options.

|System Design With Driver

LSTNT NP NT NV NPT NTNY N NT YL NT NN VLT YN N NN T N7V

Determines the optimum design for a hyperbolic-exponential horn loudspeaker
given the driver parameter values and the required operating frequency
range. Horn flare parameter T can be entered as an optional input by
double-clicking the upper rolloff corner frequency label. The tool is
enabled when the input parameters window is in edit mode.

|System Design From Specifications

Determines the optimum design for a hyperbolic-exponential horn loudspeaker
given the system parameter values and the required operating frequency
range.



|Resize Wizard
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Scales the size of a specified loudspeaker system, including driver
parameter values.

The degree to which a loudspeaker system can be re-scaled is specified by a
resize factor, or by entering a value for driver diaphragm piston area Sd.
Double-clicking on the 'Resize factor' label selects the Sd option. The
value for driver voice coil dc resistance Re can also be specified.

The response of a specified loudspeaker system can be shifted up or down in
frequency without changing the curve shape, by decreasing or increasing the
system size.

The tool is enabled when the input parameters window is in Edit mode. Not
applicable to ME1l or ME2 records, or when the driver has lossy inductance,
semi-inductance or frequency-dependent damping specified.

| Loudspeaker Wizard

Automatically re-calculates the results for a specified loudspeaker system
in real time, as input parameter values are changed. The tool is
applicable to direct radiator loudspeakers, single segment conical and
parabolic horns, single segment closed mouth exponential horns, and all
multiple segment horns.

When the wizard is used with stepped segments the final segment at the horn
mouth end can have a conical, exponential or parabolic profile. Other
segments will be cylindrical regardless of their specified flare rates.

The value of the mouth area slider can be set independently using the
Manual option, or automatically if a cylindrical final segment is required.

A green marker line indicating the fundamental resonance frequency can be
added to the power, impedance and displacement charts by double-clicking on
any of the charts. The marker can be removed by pressing the Esc key.
Moving the mouse pointer over the marker line shows the resonance frequency
value.

Double-click anywhere on the power chart Y-axis vertical SPL scale to
switch from the default 5 dB increments to either 3 dB or 6 dB increments.

Double-click anywhere on the group delay chart to switch to the group delay
per period chart. Double-click anywhere on the group delay per period
chart to switch back to the group delay chart.

Double-click anywhere on the group delay chart Y-axis vertical scale to add
a green 1/f limit guideline. Double-click again to add a red Claus Futtrup



limit guideline. Press the Esc key to remove the 1/f limit guideline and
press the Esc key a second time to remove the Claus Futtrup limit
guideline.

The Claus Futtrup audible group delay threshold limit guideline in
milliseconds is given by the expression:

GDlimit = 1000 * 1.1606 / (5.6413 * f ~ ©0.81511 - f)
Where f is the frequency in hertz.

Double-click anywhere on the group delay per period chart Y-axis vertical
scale to switch the chart range from the default 1 cycle to either 2
cycles, 5 cycles, 10 cycles or 20 cycles.

For direct radiator closed-box systems, the value of total quality factor
Qtc is displayed when the Chamber input parameters option is selected.

For passive radiator systems, double-click on the Spl slider control label
when the Chamber input parameters option is selected to specify up to 9
passive radiators. Double-click on the Mmp slider label to specify the
mass in grams to be added to each passive radiator diaphragm. Double-click
on the Added Mass slider label to return to the Mmp slider.

Absorbent filling material can be included in the horn segments of a
Loudspeaker Wizard system by selecting the Filling option.

The airflow resistivity of the absorbent filling material in each segment
is specified in mks rayls/m using the Frl slider controls. If a Frl slider
value is changed while the Ctrl key is pressed, all segments are set to the
same resistivity value.

The Tall sliders can be used to partially fill segments with absorbent
material. The first half of the slider fills the segment from the throat
end, and the second half fills the segment from the mouth end. For horn 2
in a compound horn system, the first half of the slider fills the segment
from the mouth end, and the second half fills the segment from the throat
end. If a Talll slider value is changed while the Ctrl key is pressed, all
segments are filled to the same percentage value.

When the airflow resistivity value is less than 1000 mks rayls/m and the
Schematic and Filling options are selected, the total amount of Polyfill
absorbent material required to achieve the specified resistivity value is
shown in kilograms. Double-click on the total value to display the amount
in the currently selected segment.

The initial slider control settings and chart results are saved as a
reference baseline when the tool is selected. Up to four sets of values
can be temporarily stored and recalled while the wizard is open by clicking
the appropriate memory button or pressing the equivalent function key.



Pressing Ctrl+C when the power response chart is displayed captures the
current results. Pressing Ctrl+V shows or hides previously captured
results. Not applicable when room gain is included.

Press the V key to instantly check the schematic diagram. Release the V
key to immediately return to the previously displayed chart.

To change the flare of a horn segment, double-click on the label above the
length slider control. To change the Manual / Auto setting of an area
slider control, double-click on the label above the area slider.

To change the flare of a throat adaptor or absorber chamber port,
double-click on the label above the Lp slider control.

To change the Eg, Vel or Acc option, double-click on the label above the
slider control.

To change the frequency range, double-click on the chart frequency label.
The 100 to 20000 hertz range is not applicable when absorbent filling
material is included.

To directly set a slider control to a specified value, key in the value and
then press Enter while the control has the focus. For the Tall slider, a
directly entered positive percentage value will fill the currently selected
segment with absorbent material from the throat end, and a directly entered
negative percentage value will fill the segment from the mouth end. For
horn 2 in a compound horn system, a directly entered Tall positive
percentage value will fill the currently selected segment with absorbent
material from the mouth end, and a directly entered negative percentage
value will fill the segment from the throat end.

To quickly move through a slider control value range, press and hold the
Home or End key while the slider has the focus.

To reset a slider control to its baseline value, press B while the control
has the focus. To reset all slider controls to their baseline values,
press Alt+B. To save a new baseline with the current slider control
settings and chart results, press Ctrl+Alt+B.

Imported room gain data can be included in the Loudspeaker Wizard
acoustical power results by either clicking the Include Gain button in the
Memory & Width window or by pressing the F7 function key. Not applicable
when the chart frequency range is set to 1 to 2000 hertz.

Data from a Hornresp record file can be imported into the Loudspeaker
Wizard by either clicking the Import Data button in the Memory & Width
window or by pressing the F6 function key when the wizard has the focus.

The active or parametric equaliser filter option in the Filter Wizard tool



can be selected from the Loudspeaker Wizard by either clicking the Filter
Wizard button in the Memory & Width window or by pressing the F8 function
key.

SPL magnitude and phase values can be saved to a tab-delimited text (.txt)
or frequency response data (.frd) file for use with other loudspeaker
design software tools by either clicking the Export Data button in the
Memory & Width window or by pressing the F9 function key with the Power
output option selected. Frequency values increase logarithmically from 10
to 20000 hertz, or from 1 to 2000 hertz.

Electrical impedance magnitude and phase values can be saved to a
tab-delimited text (.txt) or impedance response data (.zma) file for use
with other loudspeaker design software tools by either clicking the Export
Data button in the Memory & Width window or by pressing the F9 function key
with the Impedance output option selected. Frequency values increase
logarithmically from 10 to 20000 hertz, or from 1 to 2000 hertz.

Diaphragm displacement values can be saved to a tab-delimited text (.txt)
or comma separated values (.csv) file by either clicking the Export Data
button in the Memory & Width window or by pressing the F9 function key with
the Displacement output option selected. Frequency values increase
logarithmically from 10 to 20000 hertz, or from 1 to 2000 hertz.

The constant width dimension of a direct radiator enclosure or rectangular
horn having two parallel sides can be altered while leaving the
cross-sectional height dimensions unchanged, by using the Width slider
control in the Memory & Width window.

Specify the initial width dimension using the Width slider and then
double-click on the Width label to switch the slider to the width
adjustment mode. Adjust the slider to vary the horn or enclosure width
from the initial value. Double-click on the label to reset to the initial
width.

Select the Lossy Le check box on the schematic diagram window to more
accurately simulate the power response and diaphragm displacement of
systems having drivers with large motors. The lossy inductance model was
derived empirically from experimental data.

Select the Semi-Inductance Model check box on the schematic diagram window
to use the semi-inductance model.

Select the FDD Model check box on the schematic diagram window to use the
frequency-dependent damping model.

|[Multiple Entry Horn Wizard

Automatically re-calculates the results for a specified two-way or



three-way multiple entry horn loudspeaker system in real time, as input
parameter values are changed.

CoEntrant, Unity and Synergy loudspeakers are examples of multiple entry
horn systems.

A Nd record is used to specify the horn system and HF driver at the horn
throat. A ME1 record is used to specify the MF drivers at the first offset
entry point and a ME2 record is used to specify the LF drivers at the
second offset entry point.

A three-way system requires the Nd record to have at least three segments,
and both a ME1 and a ME2 record to be activated.

A two-way system requires the Nd record to have at least two segments, and
a ME1l record to be activated. If a ME2 record is also activated it will be
disregarded if only two segments are specified in the Nd record.

The Tools menu command is enabled when the input parameters window for a Nd
record is in edit mode and at least two horn segments have been specified,
and a ME1l record has been previously activated.

Double-click anywhere on the power chart Y-axis vertical SPL scale to
switch from the default 5 dB increments to either 3 dB or 6 dB increments.

The initial slider control settings and chart results are saved as a
reference baseline when the tool is selected. Up to four sets of values
can be temporarily stored and recalled while the wizard is open by clicking
the appropriate memory button or pressing the equivalent function key.

Pressing Ctrl+C when a power response chart is displayed captures the
current results. Pressing Ctrl+V shows or hides previously captured
results.

Press the V key to instantly check the schematic diagram. Release the V
key to immediately return to the previously displayed chart.

To change the flare of a horn segment, double-click on the label above the
length slider control. To change the Manual / Auto setting of an area
slider control, double-click on the label above the area slider.

Pressing the Ctrl key while adjusting an Amplifier Eg or Rg slider control
sets the other Eg or Rg sliders to the same value.

The Amplifier delay slider control enables the offset ME1l and ME2 drivers
to be time-delayed (positive delay slider value) or time-advanced (negative
delay slider value) relative to the HF driver at the horn throat. By
default the delay is expressed as an equivalent distance in centimetres.
Double-clicking the delay caption automatically sets the slider to the
actual physical path length difference. Double-clicking the delay value



changes distance to time, in milliseconds.

To change the alignment type of a band pass filter, double-click on the
alignment label. To change the slope units from dB per octave to dB per
decade, double-click on the slope label.

To switch a band pass filter on or off, double-click on the On / Off label
for that filter.

To switch a parametric equaliser filter band on or off, double-click on the
On / Off label for that band. To select either a peaking EQ filter, a low
shelving filter, a high shelving filter, a low pass filter or a high pass
filter for a given band, double-click on the filter label for that band.
Press the Esc key to hide the green frequency marker.

Press the F5 function key to restore all band pass and parametric equaliser
filter slider controls to their initial default settings.

To change the frequency range, double-click on the chart frequency label.

To directly set a slider control to a specified value, key in the value and
then press Enter while the control has the focus.

To quickly move through a slider control value range, press and hold the
Home or End key while the slider has the focus.

To reset a slider control to its baseline value, press B while the control
has the focus. To reset all slider controls to their baseline values,
press Alt+B. To save a new baseline with the current slider control
settings and chart results, press Ctrl+Alt+B.

Select the Schematic option to display the schematic diagram of the
specified two-way or three-way multiple entry horn loudspeaker system.

Select the Power 1 option to display the horn mouth acoustical power output
of the driver assembly located at the horn throat. The baseline shows the
total horn mouth acoustical power output.

Select the Power 2 option to display the horn mouth acoustical power output
of the driver assembly located at the first offset entry point. The
baseline shows the total horn mouth acoustical power output.

Select the Power 3 option to display the horn mouth acoustical power output
of the driver assembly located at the second offset entry point. The
baseline shows the total horn mouth acoustical power output.

Select the Total Power option to display the acoustical power output of the
complete system.

Select the Impedance 1 option to display the magnitude of the electrical



input impedance of the driver assembly located at the horn throat.

Select the Impedance 2 option to display the magnitude of the electrical
input impedance of the driver assembly located at the first offset entry
point.

Select the Impedance 3 option to display the magnitude of the electrical
input impedance of the driver assembly located at the second offset entry
point.

Select the Displacement 1 option to display the driver diaphragm
displacement of the driver assembly located at the horn throat.

Select the Displacement 2 option to display the driver diaphragm
displacement of the driver assembly located at the first offset entry
point.

Select the Displacement 3 option to display the driver diaphragm
displacement of the driver assembly located at the second offset entry
point.

|Driver Front Volume

LSTNT NP NT NV N NT NTNE N NI N NN NN VI ST

A stand-alone tool that calculates the effective air volume between the
driver diaphragm and the front plane of the driver, given D1 the inside
diameter of the mounting sealing strip, D2 the inside diameter of the
diaphragm suspension, D3 the diameter of the dust cap, H1 the thickness of
the sealing strip, H2 the perpendicular distance from the front plane to
the edge of the dust cap, and H3 the perpendicular distance from the front
plane to the centre of the dust cap.

The driver front volume calculated by the tool must be manually added to
Vtc, it is not added automatically.

Double-click the front volume value to show front cross-sectional area.
The Tools menu command is enabled when the input parameters window is in
edit mode. The tool can also be selected by double-clicking the Vtc or Atc

label or text box in edit mode.

|vView Schematic

LSLNL VLN NV NY N NTNY LN NI N V)

Displays the loudspeaker schematic diagram and system volume.

| Frequency Range

Changes the chart frequency range from the default setting of 10 to 20000



hertz to 1 to 2000 hertz.

| Sample

LSLVL VLT N VN

The Sample menu command can be selected from any default chart window, or
by pressing F3 or double-clicking the chart.

Single-clicking a chart will provide abbreviated data at the frequency
given by the mouse pointer location. The sampling frequency can be changed
by dragging the red marker line, or by using the Up, Down, Left, Right,
Home or End navigation keys. Press the Esc key to release a set frequency
point.

Acoustical impedance chart ~ Calculates the normalised throat acoustical
resistance and reactance and the actual throat acoustical resistance and
reactance at any given frequency between 1 and 20000 hertz, or between 0.1
and 2000 hertz.

Acoustical power chart ~ Calculates the constant directivity sound pressure
level, electrical input power, acoustical output power, power conversion
efficiency, horn throat peak sound pressure and horn throat peak particle
velocity at any given frequency between 1 and 20000 hertz, or between 0.1
and 2000 hertz. When a single-segment horn is sampled the second-harmonic
distortion is also calculated. When the maximum SPL response is sampled
the acoustical output is shown as either power or displacement limited, and
the input voltage and Pmax diaphragm displacement are given. When the
power compression response is sampled the thermal power compression is also
shown, expressed in decibels.

Electrical impedance chart ~ Calculates the driver electrical input
impedance magnitude and phase at any given frequency between 1 and 20000
hertz, or between 0.1 and 2000 hertz.

Diaphragm displacement chart ~ Calculates the driver diaphragm mean-to-peak
displacement, peak velocity and peak acceleration at any given frequency
between 1 and 20000 hertz, or between 0.1 and 2000 hertz.

Phase response chart ~ Calculates the system standard wrapped phase shift
or the system corrected phase shift at any given frequency between 1 and
20000 hertz, or between 0.1 and 2000 hertz.

Group delay chart ~ Calculates the system group delay, equivalent distance
travelled and equivalent wavelengths at any given frequency between 1 and
20000 hertz, or between 0.1 and 2000 hertz.

Beam width chart ~ Calculates the directivity pattern -6 dB beam width at
any given frequency between 1 and 20000 hertz, or between 0.1 and 2000
hertz.



| Compare

LSLVL VLN NY NP VPN

Displays the current and previous or captured acoustical impedance,
acoustical power, acoustical pressure, electrical impedance, diaphragm
displacement, phase response, group delay or beam width results on the same
chart.

Previous results are used in comparisons by default. Press Ctrl+C to
capture the current results or Ctrl+R to release captured results. Results
can also be captured or released by right-clicking on any chart.

Press F4 to show or hide the previous or captured results.

|Output

LSLVL VL N7 N VPN

Calculates the acoustical power output from the front side of the driver,
the acoustical power output from the rear side of the driver, or the
combined front and rear acoustical power outputs. The chosen output option
is retained until changed by the user, or until a different record is
selected, at which time the default output option is restored. The default
option calculates the combined acoustical power output.

For a direct radiator in a vented-box enclosure loudspeaker system, the
Combined output option combines the direct radiator acoustical power output
with the port acoustical power output.

The path length from the rear side of the driver diaphragm to the port
outlet is assumed to be equal to Lrc plus Lpt, as shown in the schematic
diagram.

The distance between the radiating side of the driver diaphragm and the
port outlet is specified using the acoustic path length parameter. The
acoustic path length is the length of the shortest acoustic path between
the two outputs (assumed to be point sources).

Press the F9 function key to permanently save the entered path length
value.

For a finite damped transmission line enclosure loudspeaker system, the
Combined output option combines the transmission line acoustical power
output with the direct radiator acoustical power output.

For a finite front-loaded horn loudspeaker system with no rear chamber, the
Combined output option combines the horn acoustical power output with the
direct radiator acoustical power output.

For a finite back-loaded horn loudspeaker system, the Combined output
option combines the horn acoustical power output with the direct radiator



acoustical power output. The direct radiator cannot be located inside the
horn mouth.

For a finite horn-loaded vented-box enclosure loudspeaker system, the
Combined output option combines the horn acoustical power output with the
port acoustical power output.

For a finite offset driver horn loudspeaker system, the Combined output
option combines the horn acoustical power output with the direct radiator
acoustical power output or the port acoustical power output.

For a finite compound horn loudspeaker system, the Combined output option
combines the horn 1 acoustical power output with the horn 2 acoustical
power output.

|Directivity Response

LSTNTNTNT NV VY NT NENPNT NI NY VLT NN LN NN

Displays the far-field acoustical pressure of a direct radiating single
driver, a finite single-segment non-negative flare horn with no throat
adaptor, or a port at a specified off-axis angle, taking into account the
frequency-dependent directional characteristics of the radiating system.

Select from the acoustical power or acoustical pressure chart window.

|Directivity Pattern

LSTNL L NT NV NP NT NTNY N NI N NN NNV NN

Displays the directional characteristics of a direct radiating single
driver, a finite single-segment horn with no throat adaptor, or a port at a
specified frequency. The directivity pattern diagram shows the far-field
sound pressure at a fixed distance as a function of the off-axis angle,
expressed relative to the on-axis pressure with the maximum value
normalised to 1. The sound pressure ratio can be indicated directly or in
decibels. The -6 dB beam width angle is also given. Click on the
directivity pattern to show the pressure level and the directivity index at
a specified angle. The arrow keys can be used to change the selected
angle. For a direct radiating single driver, the value of ka (wave-number
k =2*Pi*f / c multiplied by piston radius a) is also given.

The directivity pattern can be displayed using either polar or rectangular
coordinates.

Select from the acoustical power or acoustical pressure chart window.

|Directivity Index

LSTNT NP NT NV NYNT NTNY N NI NY NN NI N VLN

Displays the directivity index in decibels versus frequency in hertz for a
specified off-axis angle in degrees. The directivity index is 10 times the



logarithm to the base 10 of the directivity factor. The directivity factor
is the ratio of the intensity on a designated axis of a sound radiator at a
given distance, to the intensity that would be produced at the same
position by a point source if it were radiating the same total acoustic
power as the radiator.

Click on the chart to show the directivity index value at a specified
frequency. The arrow keys can be used to change the selected sample
frequency.

Select from the acoustical power or acoustical pressure chart window. Only
applicable to direct radiating single drivers, finite single-segment horns
with no throat adaptor, and ports.

|Directivity Beam Width

Displays the angular distance in degrees between the two points on either
side of the principal axis of the directivity pattern where the sound
pressure level is down 6 decibels from its value on axis, versus frequency
in hertz.

Select from the acoustical power or acoustical pressure chart window. Only
applicable to direct radiating single drivers, finite single-segment horns
with no throat adaptor, and ports.

|Directivity Polar Map

Displays the far-field sound pressure at a fixed distance as a function of
the off-axis angle in degrees, versus frequency in hertz. Select the check
box to show the results normalised to the on-axis response.

Results can be sampled by moving the mouse pointer over the chart window.

A specific point can be selected by clicking or dragging on the window, and
by using the Up, Down, Left and Right navigation keys. Press the Esc key
to release a set point.

Select from the acoustical power or acoustical pressure chart window. Only
applicable to direct radiating single drivers, finite single-segment horns
with no throat adaptor, and ports.

| Impulse Response

Displays the impulse pressure versus time response of a loudspeaker system.
The maximum positive or negative amplitude value is normalised to 0.9 and
the maximum peak is positioned by default at the © msec reference point.

Select from the acoustical power or acoustical pressure chart window.



Click the Export button to save the impulse response data values to a wave
sound file. Click the Compare or Clear button or press F4 to show or hide
the comparison with the previous result.

| Impulse Spectrogram

LSTNT VL NT NV NPT NTNY N NI N NN NN VI ST

Displays the impulse spectral density, or normalised amplitude in decibels
as a function of frequency, versus time in milliseconds.

Select from the acoustical power or acoustical pressure chart window.
Results can be sampled by moving the mouse pointer over the chart window.

A specific point can be selected by clicking or dragging on the window, and
by using the Up, Down, Left and Right navigation keys. Press the Esc key

to release a set point.

|Room Gain Excluded

Displays the power response with imported room gain data excluded. Not
applicable when the 1 to 2000 hertz chart frequency range is selected.

|Room Gain Included

Displays the power response with imported room gain data included. Not
applicable when the 1 to 2000 hertz chart frequency range is selected.

|Room Gain Profile

Displays the room gain data only. Not applicable when the 1 to 2000 hertz
chart frequency range is selected.

|Maximum SPL

LS VL VLN NY VPN NT NP N STV

Displays the maximum sound pressure level in decibels that can be achieved
at 1 metre without exceeding the amplifier maximum output power Pamp, the
amplifier maximum output voltage Vamp, the amplifier maximum output current
Iamp, the driver rated thermal limited electrical input power Pmax, or the
diaphragm linear mean-to-peak displacement limit Xmax, versus frequency in
hertz. One or more of the above input parameter options can be selected by
double-clicking the On / Off labels.

Press the F9 function key to permanently save the entered Pamp, Vamp, Iamp,
Pmax and Xmax values.



| Power Compression

Displays the thermal power compression response for a given driver input
voltage and voice coil temperature, taking into account the increase in
voice coil resistance due to the coil being heated above the standard
reference value of 20 degrees Celsius.

The value of the increased voice coil resistance due to heating is
displayed in the status bar panel at the bottom of the input parameters
window when the mouse pointer is moved over the Re text box.

The design maximum voice coil temperature for a driver is typically about
200 degrees Celsius. The Re input parameter value is assumed to be the
resistance of the voice coil at 20 deg C.

In most cases the specified driver voice coil temperature will be an
estimate only, due to the difficulty in determining the actual precise
temperature. The response results should therefore be taken as indicative
and not exact.

|[Multiple Speakers

LSTNT NP NT NV NYNT NTNY N NI NY NN NN VLN

Displays the acoustical power output response of a given multiple
loudspeaker array connected to a single amplifier.

|Filter Wizard

LSLVT VL NT NV NENY NENENT NI NN

Automatically re-calculates the results for a specified filter system in
real time, as input parameter values are changed. The Le Cléac'h high pass
passive filter option provides for two-stage impedance equalisation and
high frequency uplift.

The tool can be accessed from the acoustical power, electrical impedance,
diaphragm displacement, phase response or group delay window.

Click the On button to include the current active and parametric equaliser,
passive, or Le Cléac'h filter settings when calculating results. Click the
Off button to exclude the filter settings.

The Filter Wizard is not applicable when the Vel constant diaphragm
velocity or Acc constant diaphragm acceleration option is selected, or when

a room gain profile is displayed.

Select the Schematic option to display the network schematic diagram of the
specified passive filter.

Select the Power or Pressure option to display the acoustical power or



acoustical pressure of the specified passive or active filter and
loudspeaker system.

Double-click anywhere on the power or pressure chart Y-axis vertical SPL
scale to switch from the default 5 dB increments to either 3 dB or 6 dB
increments.

Select the Impedance option to display the magnitude of the electrical
input impedance of the specified passive filter and loudspeaker system.

Select the Displacement option to display the driver diaphragm displacement
of the specified passive or active filter and loudspeaker system.

Select the Phase option to display the phase response of the specified
passive or active filter and loudspeaker system.

Select the Delay option to display the group delay or group delay per
period of the specified filter and loudspeaker system.

Double-click anywhere on the group delay chart to switch to the group delay
per period chart. Double-click anywhere on the group delay per period
chart to switch back to the group delay chart.

Double-click anywhere on the group delay chart Y-axis vertical scale to add
a green 1/f limit guideline. Double-click again to add a red Claus Futtrup
limit guideline. Press the Esc key to remove the 1/f limit guideline and
press the Esc key a second time to remove the Claus Futtrup limit
guideline.

The Claus Futtrup audible group delay threshold limit guideline in
milliseconds is given by the expression:

GDlimit = 1000 * 1.1606 / (5.6413 * f ~ 0.81511 - f)

Where f is the frequency in hertz.

Double-click anywhere on the group delay per period chart Y-axis vertical
scale to switch the chart range from the default 1 cycle to either 2
cycles, 5 cycles, 10 cycles or 20 cycles.

Select the Impulse option to display the impulse response of the specified
filter and loudspeaker system. Not applicable when the Filter Wizard is

selected from the Loudspeaker Wizard, or when room gain is included.

Select the Filter Gain option to display the gain response of the specified
filter.

Select the Filter Phase option to display the phase response of the
specified filter.



Select the Filter Delay option to display the group delay of the specified
filter.

The initial chart results are saved as reference baselines when the tool is
selected. Up to four sets of values can be temporarily stored and recalled
while the wizard is open by clicking the appropriate memory button or
pressing the equivalent function key.

Pressing Ctrl+C when the power or pressure response chart is displayed
captures the current results. Pressing Ctrl+V shows or hides previously
captured results.

Press the V key to instantly check the passive or Le Cléac'h filter network
schematic diagram. Release the V key to immediately return to the
previously displayed chart.

To change the components in the branch of a standard passive filter from
series to parallel configuration, double-click on the label below the
relevant slider group. To change the alignment type of an active filter,
double-click on the alignment label. To change the slope units from dB per
octave to dB per decade, double-click on the slope label.

To switch a parametric equaliser filter band on or off, double-click on the
On / Off label for that band. To select either a peaking EQ filter, a low
shelving filter, a high shelving filter, a low pass filter or a high pass
filter for a given band, double-click on the filter label for that band.
Press the Esc key to hide the green frequency marker.

In some parametric equaliser software packages the shelving filter 'Q

Factor' is actually S, a "shelf slope" parameter. The relationship between
Q and S is given by the expression:

S=1/(1/Q "~2-2)/ (10" (G/40) +1/ (16~ (G/ 40))) +1)

Where:

S = shelf slope parameter
Q = Q factor

G = gain

If the Active or Equaliser filter option is selected, current active and
parametric equaliser filter settings (but not passive or Le Cléac'h
settings) can be saved to the permanent data record by clicking the Save
button in the Memory window, or by pressing the F9 function key.

If the Passive or Le Cléac'h filter option is selected, current active,
passive and Le Cléac'h filter settings (but not parametric equaliser
settings) can be saved to the permanent data record by clicking the Save
button in the Memory window, or by pressing the F9 function key.



To change the frequency range, double-click on the chart frequency label.
Not applicable when absorbent filling material is included in the
loudspeaker system.

To directly set a slider control to a specified value, key in the value and
then press Enter while the control has the focus.

To quickly move through a slider control value range, press and hold the
Home or End key while the slider has the focus.

To reset a slider control to its baseline value, press B while the control
has the focus. To reset all slider controls to their baseline values,
press Alt+B. Current slider control settings and chart results for the
currently selected filter can be saved as a new baseline by pressing
Ctrl+Alt+B.

Click the Reset button in the Memory window or press the Ctrl+F9 function
keys to reset current settings back to the saved settings. Press the F5
function key to restore all slider controls to their initial default
settings.

|Efficiency

LSTNTNTNT N7 NN STV NN

Displays the acoustical output power divided by the electrical input power,
or power conversion efficiency, in percent versus frequency in hertz. Does
not include the effect of filters. Click on the chart to show the
efficiency value at a specified frequency.

Select from the acoustical power chart window.

Previous results are used in comparisons by default. Press Ctrl+C to
capture the current results or Ctrl+R to release captured results. Results
can also be captured or released by right-clicking on the chart.

Press F4 to show or hide the previous or captured results.

|Driver Power

LSTNL NI NNV NN NENE NI NI N2 )

Displays the driver electrical input power in watts versus frequency in
hertz. Click on the chart to show the power value at a specified
frequency.

Select from the acoustical power chart window.
Previous results are used in comparisons by default. Press Ctrl+C to

capture the current results or Ctrl+R to release captured results. Results
can also be captured or released by right-clicking on the chart.



Press F4 to show or hide the previous or captured results.

| Sound Pressure

Displays the peak sound pressure at the horn throat, horn mouth, port
inlet, port outlet or direct radiator in pascals versus frequency in hertz.
For a multiple-segment Nd or CH horn, the peak sound pressure is also shown
at the point of minimum cross-sectional area. Click on the chart to show
the sound pressure value at a specified frequency. The throat of an 0D
offset driver or tapped horn is at S2. The throat of an 0OD1 offset driver
horn is at S3.

For an offset driver or tapped horn, the throat sound pressure is
calculated at the S2 or S3 throat when there is no throat chamber, at the
horn side of the throat chamber when there is a throat chamber but no
throat port, and at the horn end of the throat port when there is a throat
chamber and a throat port.

Select from the acoustical power chart window. Not applicable to combined
outputs.

Previous results are used in comparisons by default. Press Ctrl+C to
capture the current results or Ctrl+R to release captured results. Results
can also be captured or released by right-clicking on the chart.

Press F4 to show or hide the previous or captured results.

|Particle Velocity

Displays the peak particle velocity at the horn throat, horn mouth, port
inlet, port outlet or direct radiator in metres per second versus frequency
in hertz. For a multiple-segment Nd or CH horn, the peak particle velocity
is also shown at the point of minimum cross-sectional area.

Click on the chart to show the particle velocity value at a specified
frequency. The throat of an OD offset driver or tapped horn is at S2. The
throat of an OD1 offset driver horn is at S3.

For an offset driver or tapped horn, the throat particle velocity is
calculated at the S2 or S3 throat when there is no throat chamber, at the
horn side of the throat chamber when there is a throat chamber but no
throat port, and at the horn end of the throat port when there is a throat
chamber and a throat port.

Select from the acoustical power chart window. Not applicable to combined
outputs.

Previous results are used in comparisons by default. Press Ctrl+C to



capture the current results or Ctrl+R to release captured results. Results
can also be captured or released by right-clicking on the chart.

Press F4 to show or hide the previous or captured results.

|Range

LSLVL NI NN )

When selected from the acoustical impedance chart window, sets the
acoustical impedance chart range.

When selected from the electrical impedance chart window, sets the
electrical impedance chart range. Select Zoom to optimise the scale for
the resonance peak.

When selected from the group delay chart window, sets the group delay chart
range.

| Impedance Phase

Displays the electrical impedance phase in degrees versus frequency in
hertz. Click on the chart to show the phase value at a specified
frequency.

Previous results are used in comparisons by default. Press Ctrl+C to
capture the current results or Ctrl+R to release captured results. Results
can also be captured or released by right-clicking on the chart.

Press F4 to show or hide the previous or captured results.

|Diaphragm Pressure

LSTNL N7 NT NV NP NT ST NY N NTNY VL NT NTNY VL N7V

Displays the peak sound pressure at the driver diaphragm in pascals versus
frequency in hertz. Click on the chart to show the pressure and force at a
specified frequency. Total pressure is the difference between the
pressures on the front and rear sides of the diaphragm with phase taken
into account.

Select from the diaphragm displacement chart window.

Previous results are used in comparisons by default. Press Ctrl+C to
capture the current results or Ctrl+R to release captured results. Results
can also be captured or released by right-clicking on the chart.

Press F4 to show or hide the previous or captured results.

|velocity

LIV LN YV S N7V



Displays the driver diaphragm peak velocity in metres per second versus
frequency in hertz. Click on the chart to show the velocity value at a
specified frequency.

Select from the diaphragm displacement chart window.

Previous results are used in comparisons by default. Press Ctrl+C to
capture the current results or Ctrl+R to release captured results. Results
can also be captured or released by right-clicking on the chart.

Press F4 to show or hide the previous or captured results.

|Acceleration

LSTNL NI NNV N N NENE NI NI N2 )

Displays the driver diaphragm peak acceleration in metres per second per
second versus frequency in hertz. Click on the chart to show the
acceleration value at a specified frequency.

Select from the diaphragm displacement chart window.

Previous results are used in comparisons by default. Press Ctrl+C to
capture the current results or Ctrl+R to release captured results. Results
can also be captured or released by right-clicking on the chart.

Press F4 to show or hide the previous or captured results.

|Delay

N~ AN

Sets the phase response chart offset delay correction. Move the slider
control to minimum to show standard wrapped phase. Select from the phase
response window.

| Throat Adaptor Designer

LSTLVLNTNT NV NYNT NTNY NPT NN NN NY VLN ST N NI NN )

A stand-alone tool that displays the flare profile of a horn throat adaptor
transition element, given D1 the entry diameter, D2 the exit diameter, Al
the entry flare tangent angle and A2 the exit flare tangent angle. The
minimum length element is calculated. The profile data can be exported.

|Wavefront Simulator
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Models sound wave propagation in horn loudspeakers. Isophase wavefronts
are shown. A warning message is displayed if the specified resolution,
frequency, element size and window size slider settings would generate
inaccurate results due to aliasing effects.



To add or delete walls, click or drag the mouse with the 'Mouse = Edit
System' option selected, or click the mouse then use the Up, Down, Left and
Right navigation keys.

To specify a straight wall, Shift+click the mouse at the line end points.

To specify a rectangular walled box enclosure, Ctrl+click the mouse at the
diagonal corners.

To specify a standard point source, Alt+click the mouse twice at the same
location.

To specify a reverse polarity point source, a time-delayed point source, or
the acoustical output power of a point source relative to the default
value, Alt+click the mouse at the proposed source location, select the
reverse polarity check box, set the power and delay slider controls to the
desired values, and then Alt+click the mouse again at the proposed source
location. Moving the mouse pointer over a point source displays the
selected polarity, power and delay settings in the caption bar at the top
of the tool. Default settings are not shown.

To delete a point source, click the mouse over the source.

To specify a standard driver source, Alt+click the mouse at the diaphragm
end points.

To specify a reverse polarity driver source, a time-delayed driver source,
or the acoustical output power of a driver source relative to the default
value, Alt+click the mouse at the diaphragm first end point, select the
reverse polarity check box, set the power and delay slider controls to the
desired values, and then Alt+click the mouse at the diaphragm second end
point. Moving the mouse pointer over a driver source displays the selected
polarity, power and delay settings in the caption bar at the top of the
tool. Default settings are not shown.

To delete a driver source, click and drag the mouse over the source.

By default the delay slider control is calibrated in delay distance in grid
elements. To change the calibration scale of the delay slider,
double-click on the delay value to select delay time in milliseconds, delay
distance in centimetres or delay phase angle in degrees.

For custom designs, double-click on the element size slider label to switch
to window size.

Custom designs can be permanently saved by selecting the 'Save Current
Design' option. Saved designs can be opened by selecting the 'Open Saved
Design' option.



Custom and imported designs are retained when the resolution slider setting
is changed. Systems can be drawn using one resolution and analysed using
another. The window size is re-scaled automatically.

|options
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Sets the throat chamber and rear chamber resonance masking and default
result window options.

|FILE MENU

| New

~ A~

Creates a new data file.

| Open

~A A A

Opens an existing data file.

| Editor

LSLVL LN N7 N7V

Moves or copies records from one data file to another, or deletes records
from a data file.

|Undo

~ A~ A

Rolls back changes made to current record input parameters window values
and settings, with the exception of changes generated using the Multiple
Entry Horn Wizard.

| Redo

~ A A

Rolls forward previously undone changes made to current record input
parameters window values and settings.

| Copy Driver
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Copies driver parameter values from the current record to the Clipboard.

|Paste Driver
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Pastes driver parameter values from the Clipboard to the current record.

The File menu command is enabled when the input parameters window is in
edit mode.

|Copy Driver to Database
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Copies driver parameter values from the current record to the driver
database.

Not applicable to the default record.

|Paste Driver from Database
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Pastes driver parameter values from the driver database to the current
record.

The File menu command is enabled when the input parameters window is in
edit mode. The menu command can also be selected by right-clicking any
driver parameter label in edit mode.

|Find

~ A A A

Searches for records that match the given comment text and filter.

The Page Up, Page Down, Home, End and Enter keys can also be used to move
from one record to another, when the input parameters window is displayed.

| Sort
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Sorts records in comment-ascending alphanumeric order.

| Import Hornresp Record

Loads input parameter data values from an exported record file.

| Import Room Gain Profile
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Loads room gain profile data values from a text (.txt) or frequency
response data (.frd) file.

The file must not contain any header or footer comment records.



File data records must be listed sequentially in order of increasing
frequency, with the first field in each record being the frequency value,
and the second field being the room gain value. Additional record fields,
and any records outside the frequency range 10 to 20000 hertz, are
disregarded. Room gain values must be relative to a zero decibel reference
point.

Fields in a record can be space or tab delimited, and field values can have
either a period or a comma as the decimal separator.

| Export Hornresp Record
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Saves current record input parameter data values to a Hornresp export
record file. Record must be valid. Select from the input parameters
window.

Active and parametric equaliser filter settings are exported by default.
To export active, passive and Le Cléac'h filter settings, double-click on
the red Equaliser label to select the Passive option, before saving the
export file.

| Export AkAbak Script
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Saves current record input parameter data values to an AkAbak script file.
Record must be valid. Select from the input parameters window.

Cannot export open baffle, ME1l, ME2, BP4, BP6, BP8, DBR or ABC records.

| Export Horn Data
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Saves schematic diagram data values to a tab-delimited text (.txt) or comma
separated values (.csv) file. Select from the schematic diagram window.

Axial length values for each horn segment increase linearly from zero to
the segment length. The length increment for each segment can be set to a
specified value in centimetres.

Con width flare ~ Rectangular cross-section horn segment width changes
linearly with axial length. The height at any point equals the
cross-sectional area divided by the width at that point.

Exp width flare ~ Rectangular cross-section horn segment width changes
exponentially with axial length. The height at any point equals the
cross-sectional area divided by the width at that point.

Uni width flare ~ Rectangular cross-section horn segment cross-sectional



area aspect ratio changes uniformly with axial length.

Click the Preview button to show the diameter profile for an axisymmetric
horn, the width and height profiles for a rectangular horn, and the petal
profile for a petal horn.

The flat profile of the left and right side walls of a rectangular
cross-section horn can be determined by plotting the schematic diagram
exported Height / 2 values against Side Len as the X-axis centre line. The
flat profile of the top and bottom horn walls can be determined by plotting
Width / 2 values against Top Len as the X-axis centre line.

The flat profile of a petal horn side wall can be determined by plotting
Width / 2 values against Side Len as the X-axis centre line.

The 2007 flare profile used in the Le Cléac'h horn simulation model becomes
slightly inaccurate near the horn mouth. The error is not large enough to
make any practical difference to predicted results, however for
construction purposes the exact axisymmetric profile can be previewed and
exported if required by selecting the Exact Profile option.

For a compound horn, only the horn 1 data can be previewed and exported.

| Export All Chart Data
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Saves data values for all calculated charts to a tab-delimited text (.txt)
or comma separated values (.csv) file. Frequency values increase
logarithmically from 10 to 20000 hertz, or from 1 to 2000 hertz. Select
from any chart window.

| Export Za + Phase
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Saves horn throat acoustical impedance magnitude and phase values to a
tab-delimited text (.txt) or comma separated values (.csv) file for use
with other loudspeaker design software tools. Frequency values increase
logarithmically from 10 to 20000 hertz, or from 1 to 2000 hertz. Select
from the acoustical impedance window.

| Export SPL + Phase

Saves SPL magnitude and phase values to a tab-delimited text (.txt) or
frequency response data (.frd) file for use with other loudspeaker design
software tools. Frequency values increase logarithmically from 10 to 20000
hertz, or from 1 to 2000 hertz. Select from the acoustical power or
acoustical pressure window.

| Export Ze + Phase
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Saves electrical impedance magnitude and phase values to a tab-delimited
text (.txt) or impedance response data (.zma) file for use with other
loudspeaker design software tools. Frequency values increase
logarithmically from 10 to 20000 hertz, or from 1 to 2000 hertz. Select
from the electrical impedance window.

|Print

Prints the input parameter values and displayed schematic diagram or chart.

|Exit

~A A A A

Closes the Hornresp application.

|HELP MENU

|Hornresp Help
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Hornresp help file. Can be selected from any window by pressing the F1
function key.

| Input Wizard
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Enables a loudspeaker system to be specified by selecting from a set of
context-sensitive options, and for the input parameter values of a
representative example of the specified loudspeaker to be automatically
generated. Press the Home key to return to the first page of the wizard.
The wizard can be selected from the input parameters window by pressing the
F7 function key.

| About Hornresp

LSLNT VLN NV NE N NTNY NN NI N N

Hornresp version and product number, and licence and copyright details.

| LOUDSPEAKER MODELS

|Direct Radiator in an Infinite Baffle
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Set Ang = 2 x Pi, S1 to L45 = @ and Vrc and/or Lrc = 0.

|Direct Radiator in an Open Baffle

Set S1 = baffle area and S2 to L45 = 0.

By default, the combined diaphragm side 1 plus diaphragm side 2 acoustical
power output is calculated. The Output tool can be used to determine the
diaphragm side 1 output or the diaphragm side 2 output.

|Direct Radiator in a Closed-Box Enclosure
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Select the 'Rear Lined' option from the Chamber Type tool and set S1 to L45
= @ and Vrc and Lrc > ©. To specify acoustical lining material in the rear
chamber set Fr and Tal > 0.

|Direct Radiator in a Closed-Box Enclosure With Offset Driver

Specify two segments, select the OD offset driver option and double-click
the Cir or Fta label in edit mode to select the Clo closed horn mouth
option. Set Vrc, Lrc, Vtc and Atc = 0.

Use the Loudspeaker Wizard to add absorbent filling material to horn
segments as required.

Set L12 = 0.01 cm if the driver is not offset.

|Direct Radiator in a Closed-Box Enclosure With Passive Radiator

Select the 'Rear Passive Radiator' option from the Chamber Type tool and
set S1 to L45 = 0 and Vrc and Lrc > O.

By default, the combined direct radiator plus passive radiator power output
is calculated. The Output tool can be used to determine the direct
radiator output or the passive radiator output. Use the Loudspeaker Wizard
tool to specify the mass in grams to be added to each passive radiator
diaphragm in the system.

The input parameters window Mmp label changes to red when mass is added,

and the value of the mass added to each passive radiator diaphragm can be
seen in the bottom status bar panel by moving the mouse pointer over the

Mmp label or text box.

|Direct Radiator in a Vented-Box Enclosure
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Select the 'Rear Vented' option from the Chamber Type tool and set S1 to
L45 = @ and Vrc, Lrc, Ap and Lpt > 0.

By default, the combined direct radiator plus port acoustical power output
is calculated. The Output tool can be used to determine the direct
radiator output or the port output. An inner end correction is added to
the Lpt rear chamber port tube length where appropriate. If an end
correction is added the Helmholtz resonance frequency of the specified
system can be seen in the bottom status bar panel by moving the mouse
pointer over the Ap label or text box.

| Fourth Order Band Pass Enclosure
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Select the BP4 option from the Driver Arrangement tool or press the Ctrl
key and double-click the ME2 label in edit mode to set the BP4 flag.

Press F5 or click the Wizard button to open the Loudspeaker Wizard. Set
the chamber, port, amplifier and filter slider control values by moving the
sliders or by directly keying in the value and then pressing Enter while
the control has the focus.

Sliders Lol and Lo2 specify the position of an offset driver. The default
Manual option enables the offset in each chamber to be adjusted separately.
Double-clicking the Manual option selects the Auto option. If the Auto
option is selected, setting the value of one offset slider automatically
sets the other to the same value.

Acoustical power, electrical impedance and diaphragm displacement values
can be exported for use with other loudspeaker design software tools by
either clicking the Export Data button in the Memory window or by pressing
the F9 function key, while the relevant chart is displayed.

The enclosure is modelled as shown in the schematic and system model
diagrams.

|Sixth Order Series or Parallel Band Pass Enclosure

Select the BP6S (series) or BP6P (parallel) option from the Driver
Arrangement tool or press the Ctrl key and double-click the BP4 label in
edit mode to set the BP6 flag.

A series band pass enclosure is specified by default. Double-click on the
red 'Series band pass' label in edit mode to change to a parallel band pass

enclosure.

Press F5 or click the Wizard button to open the Loudspeaker Wizard. Set



the chamber, port, amplifier and filter slider control values by moving the
sliders or by directly keying in the value and then pressing Enter while
the control has the focus. Double-click on the 'Series' or 'Parallel’
label just below the port sliders to change the enclosure type.

Set the Ap2 slider to zero to remove port tube 2 and simplify the enclosure
to a BP4 alignment. Double-click the Lp2 slider in a BP6S enclosure to
specify port tube 2 unflanged at both ends.

Sliders Lol and Lo2 specify the position of an offset driver. The default
Manual option enables the offset in each chamber to be adjusted separately.
Double-clicking the Manual option selects the Auto option. If the Auto
option is selected, setting the value of one offset slider automatically
sets the other to the same value.

Acoustical power, electrical impedance and diaphragm displacement values
can be exported for use with other loudspeaker design software tools by
either clicking the Export Data button in the Memory window or by pressing
the F9 function key, while the relevant chart is displayed.

The enclosure is modelled as shown in the schematic and system model
diagrams.

|Eighth Order Series or Parallel Band Pass Enclosure
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Select the BP8S (series) or BP8P (parallel) option from the Driver
Arrangement tool or press the Ctrl key and double-click the BP6 label in
edit mode to set the BP8 flag.

A series band pass enclosure is specified by default. Double-click on the
red 'Series band pass' label in edit mode to change to a parallel band pass
enclosure.

Press F5 or click the Wizard button to open the Loudspeaker Wizard. Set
the chamber, port, amplifier and filter slider control values by moving the
sliders or by directly keying in the value and then pressing Enter while
the control has the focus. Double-click on the 'Series' or 'Parallel’
label just below the port sliders to change the enclosure type.

Double-click the Lp2 slider in a BP8S enclosure to specify port tube 2
unflanged at both ends.

Acoustical power, electrical impedance and diaphragm displacement values
can be exported for use with other loudspeaker design software tools by
either clicking the Export Data button in the Memory window or by pressing
the F9 function key, while the relevant chart is displayed.

The enclosure is modelled as shown in the schematic and system model
diagrams.



|Double Bass Reflex Enclosure
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Select the DBR option from the Driver Arrangement tool or press the Ctrl
key and double-click the BP8 label in edit mode to set the DBR flag.

Press F5 or click the Wizard button to open the Loudspeaker Wizard. Set
the chamber, port, amplifier and filter slider control values by moving the
sliders or by directly keying in the value and then pressing Enter while
the control has the focus.

Acoustical power, electrical impedance and diaphragm displacement values
can be exported for use with other loudspeaker design software tools by
either clicking the Export Data button in the Memory window or by pressing
the F9 function key, while the relevant chart is displayed.

The enclosure is modelled as shown in the schematic and system model
diagrams.

| Aperiodic Bi-Chamber Enclosure

Select the ABC option from the Driver Arrangement tool or press the Ctrl
key and double-click the DBR label in edit mode to set the ABC flag.

Press F5 or click the Wizard button to open the Loudspeaker Wizard. Set
the chamber, port, amplifier and filter slider control values by moving the
sliders or by directly keying in the value and then pressing Enter while
the control has the focus.

Acoustical power, electrical impedance and diaphragm displacement values
can be exported for use with other loudspeaker design software tools by
either clicking the Export Data button in the Memory window or by pressing
the F9 function key, while the relevant chart is displayed.

The enclosure is modelled as shown in the schematic and system model
diagrams.

|Damped Transmission Line Enclosure
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Select the OD or 0OD1 offset driver option and use the Loudspeaker Wizard to
add absorbent filling material to horn segments as required.

Set L12 = 0.01 cm if the driver is not offset.
By default, the combined transmission line plus direct radiator acoustical

power output is calculated. The Output tool can be used to determine the
transmission line output or the direct radiator output.



| Front-Loaded Horn
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Set Vrc and Lrc > ©O.

To specify acoustical lining material in the rear chamber select the 'Rear
Lined' option from the Chamber Type tool and set Fr and Tal > 0.

To specify a throat adaptor between the throat chamber and the horn throat
select the 'Throat Adaptor' option from the Chamber Type tool and set Apl,
Lp, Vtc and Atc > ©. Double-click the Lp label in edit mode or press C, E
or P when the Lp text box has the focus to specify a conical, cylindrical,
exponential or parabolic flare throat adaptor.

By default, if no rear chamber is specified, the combined horn plus direct
radiator acoustical power output is calculated. The Output tool can be
used to determine the horn output or the direct radiator output.

|Back-Loaded Horn
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Set Vrc and/or Lrc = 0.

To specify a throat adaptor between the throat chamber and the horn throat
select the 'Throat Adaptor' option from the Chamber Type tool and set Apl,
Lp, Vtc and Atc > ©. Double-click the Lp label in edit mode or press C, E
or P when the Lp text box has the focus to specify a conical, cylindrical,
exponential or parabolic flare throat adaptor.

By default, the combined horn plus direct radiator acoustical power output
is calculated. The Output tool can be used to determine the horn output or
the direct radiator output.

|Horn-Loaded Vented-Box Enclosure With Port Exit Located Outside Horn Mouth

Select the 'Rear Vented' option from the Chamber Type tool and set Vrc,
Lrc, Ap and Lpt > o.

By default, the combined horn plus port acoustical power output is
calculated. The Output tool can be used to determine the horn output or
the port output. An end correction is added to the Lpt rear chamber port
tube length where appropriate.

|Horn-Loaded Vented-Box Enclosure With Port Exit Located Inside Horn Mouth
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Select the tapped horn option and set Vrc, Lrc, Ap and Lpt > ©.



Set L12 = 0.01 cm if the driver is not offset.

|Mass-Loaded Horn

Specify the mouth cover plate as a conical segment having negative flare
(mouth area < throat area) and a length of ©0.01 cm, and the mouth
mass-loading port tube as a cylindrical exponential segment having zero
flare (mouth area = throat area).

|offset Driver Horn

Position the driver entry point at S2 by specifying at least two conical,
exponential and/or parabolic flare segments connected in series, and
selecting the OD offset driver option from the Driver Arrangement tool or
double-clicking the Nd label in edit mode to set the OD flag.

Position the driver entry point at S3 by specifying at least three conical,
exponential and/or parabolic flare segments connected in series, and
selecting the OD1 offset driver option from the Driver Arrangement tool or
double-clicking the OD label in edit mode to set the OD1 flag.

Vtc and Atc can be used to specify a chamber between the driver diaphragm
and the throat entry point. Apl and Lp can be used to specify a port
opening between the chamber and the horn (not required if the
cross-sectional area of the opening is equal to Atc).

By default, if no closed rear chamber is specified, the combined horn plus
direct radiator or port acoustical power output is calculated. The Output
tool can be used to determine the horn output or the direct radiator or
port output. An end correction is added to the Lpt rear chamber port tube
length where appropriate.

The Loudspeaker Wizard tool can be used to change the driver position
without altering the horn length or flare.

| Two-Way or Three-Way Multiple Entry Horn
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CoEntrant, Unity and Synergy loudspeakers are examples of multiple entry
horn systems.

Specify the horn system, horn throat driver assembly, associated chambers,
amplifier and filter using a Nd record.

Specify the first offset driver assembly, associated chambers, amplifier
and filter using a ME1l record. The ME1l values of Vrc, Ap, Apl, Vtc and Atc
are the sum totals of the chamber volumes and areas for all the ME1l
drivers.



Specify the second offset driver assembly, associated chambers, amplifier
and filter using a ME2 record. The ME2 values of Vrc, Ap, Apl, Vtc and Atc
are the sum totals of the chamber volumes and areas for all the ME2
drivers.

Select the ME1l option from the Driver Arrangement tool or press the Ctrl
key and double-click the Nd label in edit mode to set the ME1l flag.

Select the ME2 option from the Driver Arrangement tool or press the Ctrl
key and double-click the ME1l label in edit mode to set the ME2 flag.

A ME1 or ME2 record can be activated or deactivated by clicking on the
designated button. Activating a ME1l record deactivates any previously
activated ME1 record. Activating a ME2 record deactivates any previously
activated ME2 record.

The Multiple Entry Horn Wizard command is included on the input parameters
window Tools menu list when a Nd record with at least two segments is
selected, and a ME1l record is active.

The lossy inductance, semi-inductance and frequency-dependent damping
models are not applicable to multiple entry horn systems.

| Tapped Horn
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Specify three or four conical, exponential and/or parabolic flare segments
connected in series, set Vrc and/or Lrc = @ and select the TH or TH1 tapped
horn option from the Driver Arrangement tool or double-click the 0OD1 label
in edit mode to set the TH flag. Double-click the TH label to set the
optional TH1 flag.

Driver entry points are at S2 and S3 for a three segment TH horn, S2 and S4
for a four segment TH horn, and S2 and S3 for a four segment TH1 horn.

Vtc and Atc can be used to specify a chamber between the driver diaphragm
and the throat entry point. Apl and Lp can be used to specify a port
opening between the throat chamber and the horn (not required if the
cross-sectional area of the opening is equal to Atc).

Vrc and Lrc can be used to specify a chamber between the driver diaphragm
and the mouth entry point. Ap and Lpt can be used to specify a port
opening between the mouth chamber and the horn (not required if the
cross-sectional area of the opening is equal to Vrc / Lrc).

The Loudspeaker Wizard tool can be used to change the driver position
without altering the horn length or flare.

| Stubbed Horn
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Select the SH1, SH2, SH3 or SH4 stubbed horn option from the Driver
Arrangement tool or double-click the CH1 label in edit mode to set the SH1
flag. Double-click again to select the SH2, SH3 or SH4 flag.

A stubbed horn system can have up to three segments, with the stub or
absorber chamber being specified using segment 4 and the absorber chamber
input port being specified using Ap2 and Lp.

Select SH1 to position the stub or absorber chamber at S1. Select SH2 for
position S2, SH3 for position S3 (at least 2 segments required) and S4 for
position S4 (3 segments required).

| Compound Horn

Select the normal driver compound horn option from the Driver Arrangement
tool or double-click the TH1 label in edit mode to set the CH flag. Horn 1
is specified using segment 1 plus segments 2 and 3 if required. Horn 2 is
specified using segment 4.

Select the offset driver compound horn option from the Driver Arrangement
tool or double-click the CH label in edit mode to set the CH1 flag. Horn 1
is specified using segments 1 and 2 plus segment 3 if required. Horn 2 is
specified using segment 4.

By default, the combined horn 1 plus horn 2 acoustical power output is
calculated. The Output tool can be used to determine the horn 1 output or
the horn 2 output.
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